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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

  

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click in the Product Search box and type the number of this unit 
standard, as shown at the right. 

4 Click on     

5 Click on   

6 

Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Book Exercise Files – V8 Windows7  Free Download 

The File Download dialog box will display.   

7 If you have Winzip use the following instructions otherwise move to step 8. 

a   Click on  .    

b   Click on the  of the  button. 

c  If My Documents folder is not displayed click on Set default unzip folder at the bottom 
of the list.  Ensure My Documents is selected then click on Select Folder. 

d    Click on the  of the  button and click on the My Documents folder.  The files will 
be unzipped. 

8 Click on and ensure My Documents folder is displayed.  Click on  

9 
Click on Open Folder which will display My Documents folder.  Right click on the zipped 
exercise file and select Extract All. Click on Extract.  A folder will be created containing the 
exercise files.   

US 2781 

US 2781 
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Files used in this book 
 

(Instructions are on previous page for downloading retrievable files from our web site.) 
 

Names of files 

AbeecoW Fashion Xpress 

Advert for Medieval Fayre Fit for Life Gym 

ASB Bank Hat 

Beads, Seeds and Shells Jury Service 

Car Motor Homes 

Cashflow P-Cruises 

Creative Caps Quotation 

Davidsons Retirement Scheme 

 

Sa
m

pl
e D

oc
um

en
t



iii 

Unit Standard 2781 Version 8 
(Windows 7) 

 

 

Title Manage and protect data in a personal computer 

Level 2 Credits 3 

 

Purpose People credited with this unit standard are able to: manage files 
in a personal computer; demonstrate knowledge of common 
threats to data stored on a personal computer and data 
protection measures used on a personal computer. 

 

Classification Computing > Generic Computing 

 

Available grade Achieved 

 
Explanatory notes 
 
1 Definitions 
 Organisational requirements mean the documented policies and procedures or 

commonly accepted practices of a workplace, school or training provider.  The 
candidate must be given access to the policy and procedures prior to being 
assessed against this unit standard. 

 Personal computer for the purposes of this standard means either a stand-alone 
or a networked computer; or digital device e.g. personal digital assistant such as 
a smart phone. 

 
2 For assessment purposes this standard is a practical demonstration of 

knowledge.  Oral or written responses may be used to clarify knowledge. 
 
3 Legislation relevant to this unit standard includes but is not limited to the: 
 Health and Safety in Employment Act 1992 
 Copyright Act 1994 
 Privacy Act 1993 
 Unsolicited Electronic Messages Act 2007. 
 
4 An assessment resource to support computing unit standards (Levels 1 to 4) 

can be found on the NZQA website at http://www.nzqa.govt.nz/for-
providers/resources/index.html.  

 
5 Students cannot use credit for both this unit standard and achievement standard 

91070, Demonstrate understanding of basic concepts of information 
management, towards a New Zealand Qualification, including a National 
Certificate of Educational Achievement. 
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Outcomes and evidence requirements 
 
Outcome 1 
 
Manage files in a personal computer. 
 
Evidence requirements 
 
1.1 Searching for and locating files on the personal computer is demonstrated 

according to organisational requirements. 
 

Range may include – browsing through directory/tree, using a search 
mechanism; 

 evidence of one is required. 
 
1.2 Folders are created in accordance with organisational requirements. 
 

Range includes – file structure, folder names relevant to the content, 
storage of files in a folder, subfolders. 

 
1.3 File management actions are performed on a computer according to 

organisational requirements. 
 

Range actions may include – creating, saving, opening, copying, 
naming, renaming, moving, deleting, archiving, retrieving, file 
size; 

 evidence of five actions is required. 
 
Outcome 2 
 
Demonstrate knowledge of common threats to data stored on a personal computer. 
 
Evidence requirements 
 
2.1 Common threats to data stored in a personal computer are described in 

terms of their impact on the data or system. 
 

Range threats may include – unauthorised access, virus/Trojan 
attack, malware, spyware, power failure, natural disaster, 
data corruption, hardware failure, network access, malicious 
script; 

 evidence of three threats is required. 
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Outcome 3 
 
Demonstrate knowledge of data protection measures used on a personal computer. 
 
Evidence requirements 
 
3.1 Measures to ensure the integrity of data held in a personal computer are 

described in terms of organisational practice. 
 

Range measures may include – back-up and restore techniques, 
frequency of saving, virus protection facility, UPS or surge 
protector, access control, personal network protection read 
only files, employee training; 

 evidence of three measures is required. 
 

3.2 Measures to secure the system from unauthorised access are described 
according to organisational practice. 

 
Range security measures may include – passwords, log-off, 

shutdown, physical security (room access, locked keyboards, 
and/or locked workstations), anti-virus/Trojan/malware 
software, firewalls; 

 evidence of three measures is required. 
 
 

Planned review date 31 December 2015 

 
Status information and last date for assessment for superseded versions 
Process Version Date Last Date for Assessment 
Registration 1 30 September 1994 31 December 2013 

Review 2 24 September 1997 31 December 2013 

Revision 3 28 July 1998 31 December 2013 

Review 4 30 July 2002 31 December 2013 

Revision 5 16 July 2004 31 December 2013 

Review 6 22 May 2009 31 December 2013 

Revision 7 18 February 2011 31 December 2014 

Review 8 15 November 2012 N/A 
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Managing Files 
 
 
 
 
 
 
 

 
Learning Outcomes 
 
At the end of this section you should be able to -  
 
 
 Use Windows Explorer to: 

- Browse through a folder structure to find files 
- View files and folders 
- Display file and folder properties 
- Use file names that clearly identify a file 
- Create a logical structure for folders and files 
- Select files 
- Create folders 
- Copy files 
- Move files 
- Rename files 
- Delete files and folders 
- Open files 

 Use the Recycle Bin 

 Search for files and folders 

 Create shortcut icons on the desktop 

 Backup and recover data 

Section 
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Getting Started in Windows  
Exercise 1 

 Turn your computer on if necessary.  (Depending on the setup of the computer, you may have 
to enter your name and password to log on to Windows.) Your desktop may look different to 
the one below; it may have a different background picture and it may contain different icons. 

 
 
Start Button 
The Start button is used to access all the programs loaded on your computer.  It also provides 
access to various Windows settings. 

Desktop 
The desktop is the first screen that appears when Windows is loaded.  You can change the look of 
the desktop by altering the background picture (called “wallpaper”), adding/removing icons, etc.   

Recycle Bin 
When files are deleted from the hard drive they are sent to the Recycle Bin, where they can be 
retrieved if necessary.   

Taskbar 
Some programs are permanently “pinned” to the Taskbar meaning that their button always 
displays even if the program is not in use.  The taskbar also displays all programs currently open as 
buttons.  An open program has a shaded box around it.  A pinned program that is not currently 
opened does not have a shaded box 

 
 
 

Windows Explorer 
A file management program used to organise files and folders, eg the files stored permanently on 
your hard drive.  The Windows Explorer button is pinned to the Taskbar by default. 

Taskbar 

Desktop 

Start button 

Your computer may 
have additional items 
on the desktop, and a 
different background 
picture. 

Recycle 
Bin 

Start button 

Internet Explorer button 
(shaded showing the 
program is open) 

Windows Explorer button 
(pinned but not open) 
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Starting a Program 
The Start button is located in the bottom left corner of the screen and is used to access programs, 
change settings, open documents, and find items in Windows. 

Exercise 2 

1 Click on the Start button .  The Start 
menu will display as shown at the right.  Your 
Start menu will contain different programs, 
depending on what is installed on your 
computer. 

2 Click on .  The All Programs 
menu will display a list of program groups and 
programs. 

 

3 Click on  to display the Accessories menu. 

4 Move your mouse pointer down to the word Paint. 

 

5 Click the left mouse button to start the Paint program.  Paint is a program that allows you to 
draw your own pictures. 
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Parts of a Window 
In Windows you will notice that many windows contain common elements.  These elements are 
labelled and described below. 
 
 
 

 
 
 

Quick Access Toolbar 
A toolbar containing buttons for commonly performed actions.  By default these buttons are Save, 
Undo and Redo, but other buttons can be added to the toolbar. 

Title Bar 
Displays the program and file name.  The Title Bar can be used to drag the window to another area 
of the screen. 

Minimize Button 
Reduces the window to a button on the Taskbar. 

Maximize Button 
Increases the size of the window to display full screen.  When a window is maximised, the 
Maximize button displays as the Restore Down button .  Clicking on the Restore Down button 
will reduce the size of the window.  

Close Button 
Closes the window (which closes the program you are currently working in). 

Close  

Maximize  Minimize  Title Bar 
Quick Access  

Toolbar 

Window Border Status Bar 

Ribbon 

Vertical 
Scroll Bar 
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Ribbon 

A strip at the top of the screen containing tabs and buttons used to perform all the functions of the 
program.   

Status Bar 
Displays information about the current file. 

Window Border 
Used to resize the window.  When the mouse pointer is moved to the edge of the window it will 
change to a double-headed arrow – click and drag to resize the window if it is not full screen. 

Vertical Scroll Bar  
A bar with arrows on either end used to scroll up and down the program screen.   
 

Working with the Minimize Button 
Exercise 3 

1 Click on the Minimize button  in the top right corner of the window. 

The Paint window will appear as a button at the bottom of the screen on the Taskbar.   

2 To restore Paint, click on  on the Taskbar.  The Paint window will be displayed as 
you left it before it was minimized. 

 
 

Working with the Maximize Button 
For this exercise it is assumed that your window starts as the default size (ie not maximised).  If 
your Paint window is maximised (fills the whole screen) click on the Restore Down  button 
before continuing with the exercise. 

Exercise 4 

1 In the Paint window, click on the Maximize button . 

The Paint window will expand to display fully on screen.  Notice that the window extends 
right out to the edges of your screen.  This allows you to see everything within the window. 

Look at the Maximize button now and you will notice that it has changed to display the 
Restore Down button . 

2 Click on the Restore Down button  to change the window back to its former size. 
 

Moving a Window 
Exercise 5 

 To move the entire window, click on the Title Bar at the top of the screen.  Hold down the left 
mouse button and drag the Paint window around the screen (the Title Bar cannot be dragged 
if the window is maximised). 
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Resizing a Window 
Exercise 6 

1 Position the mouse pointer at the right edge of the window, as shown below.  The mouse 
pointer will change to a double-headed arrow. 

  
 
 
 

2 Click and drag the mouse pointer to the left to decrease the width of the window.  Then click 
and drag to the right to increase the width.  Note that the same technique can be used to 
increase or decrease the height of the window. 

3 To resize the window both vertically and horizontally, position the mouse pointer in the lower 
right corner of the window.  Click and drag the mouse pointer diagonally away from the 
window to increase the size.    

 

4 Resize the Paint window to its original size. 
 
 

Position mouse 
pointer here  

Click and drag 
in this direction 
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Snap 
The Snap feature allows you to expand and maximise windows using one mouse move. 

Maximising using Snap   
Exercise 7 

1 To maximise the Paint window, click and drag the Title bar to the very top of the screen.   

2 To restore it again, double click at the very top of the window.   

Resizing Windows using Snap 
Snap allows you to quickly expand windows vertically.   

Exercise 8 

1 Position the mouse pointer on the bottom window border. 
2 Click and drag so that the bottom of the Paint window touches the Taskbar.  The window will 

instantly expand to touch both the top and bottom of the screen, but the width will not change.   

3 To return to the original window size, double click on the Title Bar. 
You can also “snap” a window to the left or right side of the screen.  This will make the window 
automatically resize to take up half the screen.  This is useful for comparing windows side by side. 

The Ribbon 
The Ribbon is the strip at the top of the window providing access to all the tools required for 
working with a picture. 

 
 
The Ribbon has a series of tabs along the top; click on the tab to display the Ribbon required.  The 

Ribbon in Paint is very simple and only has two tabs: Home and View .   With 
Microsoft Office programs the Ribbon has more tabs.  The Ribbon tabs for Microsoft Word are 
shown below.     

 
Exercise 9 

1 Click on the View tab   to display the View Ribbon. 

2 Click on the Home tab  to return to the Home Ribbon. 

Close Button  
The Close button  is used to close the window and exit the program. 

Exercise 10 

 Click on the Close button  to close the Paint program. 
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Notepad 
Notepad is a program supplied with Windows 7 which allows you to create very simple text 
documents. 

Exercise 11 

 Click on the Start button .  Select All Programs, Accessories.  Click on . 

Menus  
Some windows contain a menu bar at the top of the screen 
instead of a Ribbon.  Clicking on an item on the menu bar will 
display a drop-down menu.  These menus provide access to 
features found within the application.  
 
As you can see Notepad has five pull down menus. 

File   Edit   Format   View   Help 
Exercise 12 

1 Click on the word File on the Menu bar. 

A pull down menu will display different options, eg New, Open, Save, etc. (Notice shortcut 
keys appear at the right of some features.) 

2 Click on the word File on the Menu bar again to turn off the pull down menu. 

When we refer to a menu item in this book, it will appear in brackets, eg [File].  The next 
word after this will be the menu option that you are to select, eg choose [File] Page Setup 
means to click on the File menu and select the Page Setup option. 

3 Choose [File] Page Setup.  The Page Setup dialog box will display. 

Dialog Boxes 
Various dialog box options are labelled below. 

  

Sample 

Drop-Down 
List Box 

Option 
Buttons 

Command 
Buttons 
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Dialog box options are described below. 

Drop-Down List Box Click on  to drop-down a list of options. 

Option Buttons A dot in an Option button indicates the feature is turned on.  (Click in 
another Option button to change the option).  Only one circle option 
can be chosen. 

Command Buttons Clicking on OK (or pressing Enter) within a dialog box, accepts all the 
options chosen within that dialog box.   

 Clicking on Cancel (or pressing Esc), means that none of the changes 
selected within the dialog box will take effect. 

Sample Displays how text will appear with the chosen options. 

Exercise 13 

 Click on  to close the dialog box.  
 

Working with Multiple Programs 
The ability to have several programs open at one time is one of the main advantages of using 
Windows.  It is easy to switch between tasks (such as writing a letter and creating a spreadsheet).  
Data can then be transferred from one program to another, quickly and easily.   

Exercise 14 

1 With Notepad still open, click on the Start button .  Select All Programs, Accessories.  
Click on . 
Hint: Because you have opened Paint before you might find it is now pinned to the main 

Start menu.  If this is the case you can simply click on  and then click on . 

2 Click on  and select All Programs, Accessories.  Click on .  WordPad is a 
basic word processing program supplied with Windows 7. 

 

Switching from Window to Window 
Switching between programs is important when working in Windows.  It is not necessary to exit 
and re-enter programs when you want to work in more than one program or document at a time.   

The Taskbar 

The Taskbar (at the bottom of the screen) displays the programs currently open.  Each program is 
represented by a button.  At the moment, Paint, Notepad and WordPad are all open and therefore 
have a button on the Taskbar.  (On your computer other programs may also be open and therefore 
have an icon displayed.)  To switch to the required window, click on the relevant Taskbar button. 
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Peek 

Peek is a Windows 7 tool which lets you “peek” at an 
open file from the Taskbar.  Rest your mouse pointer 
over the button on the Taskbar to preview.  In the image 
at the right, Notepad is being peeked at. 

Note that in some computers, Peek may not be available.  
If you do not have access to Peek, skip to Exercise 29.   

 

 
Exercise 15 

1 Rest your mouse pointer on the Paint button on the Taskbar .  The Paint window will 
be previewed. 

2 Click on the Paint button to display the Paint window on top of all other windows. 

3 Peek at and then click on the WordPad button . 
 
 
 

Multiple Instances 
It is possible to have multiple versions of the same program running, or multiple documents open 
within one program.  When this occurs, you still only have one button on the Taskbar.  You use 
the Peek feature to preview each open version.   

In the following exercise you will open a second instance of the Paint program. 
 
Exercise 16 

1 Ensure the Paint program is still open.  Click on the Start button, click on All Programs, 
Accessories, Paint to open a second version. 

Note that on the Taskbar there is still only one Paint button. 

2 Position your mouse over the Paint button .  Peek will show a preview of the two 
versions. 

3 Move your mouse over one of the previewed Paint windows.  All other open windows will 
fade so that the one you have previewed is displayed on your screen.  (Note: this option may 
be disabled on some computers.) 

4 Click on the left Paint preview to display the window.    

5 Click on the Paint button on the Taskbar.  Note that the program does not open; Windows is 
waiting for you to select which instance of the program you want to display.   

6 Click on the preview at the right to display this version of Paint. 

7 Use the Close button to close one of the instances of the Paint program. 
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Switching Windows Using Alt Tab 

Another way of switching between windows is by using Alt Tab.   
Exercise 17 

1 Hold down the Alt key and press the Tab key.  Keep the Alt key pressed down. 

A window will appear in the centre of the screen containing an icon for each open program. 

 
2 Press the Tab key.  Each time you do this, you will be moved to another running program.  

When you have reached the program you wish to switch to, release the Alt key and it will 
appear on screen.   

3 Practise switching from window to window.  Display the Paint window. 

Viewing the Desktop 
Sometimes you may want to view your desktop, but it is covered by 
multiple windows.  Rather than minimising all windows individually, you 
can use the Show Desktop button.  The Show Desktop button can be used to 
peek at the desktop, or to instantly minimise all open windows.  The Show 
Desktop button is positioned to the right of the clock on the Taskbar.  

Holding down the Windows key  and pressing D will also display the 
desktop. 
 
 Exercise 18 

1 Position the mouse pointer over the Show Desktop button at the extreme right of the Taskbar.  
All open windows will fade so the desktop is displayed. 

2 Click on the Show Desktop button.  All windows will minimise. 

3 Click on the Show Desktop button again to restore all windows. 

Shake 
The Shake feature is used to minimise all windows on the desktop except the currently selected 
window.  You literally just shake the window to minimise all others. 
Exercise 19 

1 Click and hold on the Title bar of the Paint window. 

2 Shake the mouse pointer back and forward rapidly (you only have to make small 
movements).  All other windows will minimise. 

3 Repeat the Shake to restore all windows. 

Show Desktop 
button 
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Creating and Saving a Document 
For this exercise you will create a document in WordPad.  The document will be saved into the 
Documents library and also onto a USB drive. 

Exercise 20 

1 Display the WordPad window and type in the following document: 

Managing a Mortgage  (press Enter twice) 

The budget is usually the first and most important consideration when you’re about to build, buy or 
renovate a home, and for most people, that means a mortgage. 

Fortunately, the days of quivering at the door to the bank manager’s office are over.  Banking 
these days is a competitive business, and there are plenty of good deals available.  Banks will 
court you with mobile mortgage managers who come to your home, 24 hour service on approving 
your loan, interest ‘holidays’, prizes, and competitive fees and charges. 

2 Click on the Save button  on the Quick Access toolbar at the top left of the screen.  

.  The Save As dialog box will display. 
 

3 The 

Navigation Pane is shown at the left of the window.  If not already selected, click on 
Documents in the Libraries list.   (You will learn more about Libraries later.) 

 

4 In the File name: box type: Mortgage . 

5 Click on .  (The filename is now displayed at the top of the WordPad window.) 
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Printing and Viewing a Print Job 
Exercise 21 

1 Click on the WordPad button at the left of the Home Ribbon tab .  The WordPad 
menu will display. 

2 Click on Print .  The Print dialog box will display. 

 
3 If your computer is connected to more than one printer, ensure the correct printer is selected 

from the Select Printer list. 

4 Click on . 

Viewing and Cancelling Printing 
Once a document is sent to the printer a printer icon will appear on the Notification Area of the 

Taskbar .  Double click on this icon to view the progress of a print job.  

If the print job is small you may find the printer icon appears for a second then disappears.  The 
alternative method is to click on the Start button and select Devices and Printers 

.  A list of your installed printers will display. 

 
Right click on the printer icon and select See what’s printing to view the print jobs for that printer. 

Ctrl P 
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To cancel the print job, click on the document listed and press Delete.  Click on Yes to confirm the 
deletion.  Click on the Close button  to close the dialog box.  
 
Restarting a Stalled Print Job 
Sometimes a print job may stall, for instance if you select a printer which is not connected 
properly.  If your print job stalls, check that you have selected the right printer, the printer is turned 
on, the print cable is connected to the computer and there is paper in the printer. 

Display the print job window (click on Start, Devices and Printers, right click on the relevant 
printer and select See what’s printing).  Select the print job and choose [Document] Restart which 
will resend the print job to the printer.  Click on the Close button  to close the dialog box. 

Changing your Default Printer 
If you print to more than one printer you may need to specify the default printer which will be the 
one you will use most often. 

Exercise 22 

1 Click on  and select .  

2 The current default printer has a green tick beside it as shown below.  

 
If you want to change your default printer, right click on the printer you wish to make the 
default and select Set as default printer.   

3 Click on the Close button  to close the Devices and Printers dialog box. 
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Connecting a USB Drive 
When you connect the USB drive a dialog box similar to the one below may display, asking what 
action you want to take with the drive.  Select the option required or click on the Close button 

 at the top right corner of the dialog box to close without taking any action.   

 

Saving to a USB Drive 
Exercise 23 

1 Ensure your USB drive is connected to the computer. 

2 Ensure your WordPad document is displayed.  Click on the WordPad button  and 

click on Save As . 

3 If necessary, scroll down the Navigation Pane at the left until you see the word Computer.  
Your hard drive will be listed along with any network drives you have access to.  Your USB 
drive should be labelled with the name Removable Disk or something similar. 

 
4 Click on Removable Disk to select your USB drive. 

5 Click on . 
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Closing Windows 
Exercise 24 

1 Click on the Close button at the top right corner of the WordPad screen  to close the 
application. 

2 If asked to save changes click on . 

3 Click on the Close buttons to close the Paint and Notepad windows. 
 

Disconnecting a USB Drive 
It can be dangerous to simply pull a USB drive out of its port.  If the computer is writing data to it, 
disconnecting the drive can result in loss of data.  A safe disconnection procedure is described 
below. 

Exercise 25 

When a USB drive is connected to your computer, the Safely Remove Hardware and Eject Media 

icon  will display in the Notification Area of the Taskbar.  (This is at the right of the Taskbar 
near the clock.)  You may have to click on the Show hidden icons arrow  to view this icon. 

1 Click on the Safely Remove Hardware and Eject Media icon  (click on  if required to 
view the icon).  A list of possible options will display:   

 

2 Select the USB drive to be disconnected (eg the USB 2.0(FS) Flash Disk).  

A message will pop up from the Taskbar when it is safe to physically disconnect the drive.    

 

Sometimes when you try to disconnect your USB drive a message will display indicating that the 
drive is busy and cannot safely be disconnected.  If this occurs shut down all programs that might 
be trying to access the drive and try again. 
 

Viewing System Information 
Information regarding your computer can be viewed within the System screen.  You can use this 
screen to answer such questions as which version of Windows 7 am I running?   How much RAM 
does my computer contain?  What is the processor speed? 

Sa
m

pl
e D

oc
um

en
t



 

© Cherylprice.co.nz Limited SECTION 1    17 

 

Exercise 26 

1 Click on Start and select .  The Control Panel provides access to a wide range 
of tools you may need to customise your computer such setting up user accounts, uninstalling 
software that is no longer required and changing the look of your desktop.  

 

2 Click on to display the System and Security options. 

3 Click on .  The System screen will display similar to the one shown below (your 
system will be different).  Take a look at the details about your operating system and 
hardware. 

 
 

4 Click on the Close button . 

Operating 
System 
 

RAM CPU 
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